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Tutorial



 

The following chapter contains 13 Lessons, which show how Commo-

tion can be used for a variety of different projects.  These tutorials

include such topics as the basic Playing of clips, Painting and Onion

Skinning, AutoPaint, Super Cloning, Wire-Removal, Matte Painting,

Rotoscoping, and Motion Tracking. 
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Introduction The following tutorials demonstrate how Commotion can be used for

different types of projects. We have included several clips that will

serve as source and final footage for the projects you will be working

on. This section contains the following tutorials:

• Lesson 1: Opening and Playing Clips

• Lesson 2: Paint Tools

• Lesson 3: Clone Tools (1)

• Lesson 4: Clone Tools (2)

• Lesson 5: Advanced Write-On Effects

• Lesson 6: Painting on Frames & Fields

• Lesson 7: The Timeline

• Lesson 8: Motion Tracking (1)

• Lesson 9: Motion Tracking (2)

• Lesson 10: Motion Tracking (3)

• Lesson 11: Using Rotosplines

• Lesson 12: The FX Brush

• Lesson 13: Electric Image 3D Pan and Tilt

Each tutorial makes use of a wide variety of Commotion commands,

guiding you through them in a clear step-by-step fashion. This tutorial

does not cover all of the functions in Commotion, but will give you an

idea of how the program works.

The tutorials are designed to be done in order. Feel free to skip ahead,

but if you find you’re having trouble, go back and do the ones you

missed. Good luck!
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Lesson 1: Opening 
and Playing Clips

The ability to play back clips in realtime is what makes working in Com-

motion so exciting. In this lesson you will learn how to use the following

features:

• Opening Clips

• The Player Palette

• Playing Footage - loop and rock & roll

• Adjusting the range of Live Frames

• Viewer Tool

• Drag-Shrink Clip

• Collapse and Resize the Clip Window

OPENING A CLIP

1. Launch Commotion by double-clicking on its icon in the Finder.

2. Choose Open from the File menu. The Open Dialog Box appears.

Find the file piggybank.mov in the Lesson 1 folder. Click OK. The

Load Frames dialog appears.

3. To load the maximum number of frames, leave all the settings at

their default, and click OK. 

Figure 4:1  The Load Frames Dialog

Command-O
Open

KEYBOARD SHORTCUT
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4. You will see a progress bar as the movie loads. When it finishes the

clip will open in Commotion.

Figure 4:2  Loading the Movie

PLAYING THE CLIP

1. If it is not already visible, open the Player Palette by selecting it

from the Window Menu or by pressing the F6 key.

Figure 4:3  The Player Palette

2. Set the frame rate to 30 fps by selecting 30 from the Frame Rate

popup in the Player Palette.

3. Click on the Play button or press the Space bar to play the clip. The

footage will play to the end and then loop back to the beginning

and continue to play until you stop it.

4. Click on the Stop button or press the Space bar to stop the foot-

age.

5. Click on the Play Mode button. There are three different modes of

play:

• Once-Though plays footage once through and stops.

F6
Show/Hide Player Palette

Space
Play

Space or Command-Period
Stop

Shift-Space
Play Selection Range

Page Up or Z
Reverse One Frame

Page Down or X
Forward One Frame

KEYBOARD SHORTCUT
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• Loop continually plays and loops footage until you press stop.

• Rock and Roll plays footage forward; when it reaches the end of

the clip it plays the footage backward.

6. Use the Play Mode button to toggle through the different states,

and play the footage with each setting to see the difference.

USING AUTO SPOOL

The frames of a clip that Commotion has loaded into RAM are called

Live Frames. You have immediate access to Live Frames and can

manipulate and play them instantly. As you advance through the clip to

the end of the Live Frames, by default Commotion will loop back to the

first Live frame.

If you would rather continue advancing the frames forward, turn on

Auto Spool by clicking on the Auto Spool button in the Player palette.

This will cache the first Live Frame to the scratch disk and load the next

available frame into RAM.

If you are at the last Live frame in a clip and would like to advance for-

ward to the next frame, click the Frame Advance button to move back-

ward or forward one frame. Alternately you can use the Z and X or Page

Up and Page Down keys.

ADJUSTING THE LIVE FRAME RANGE

There are three ways to adjust the Live Frame range:

• Grab the top slider on the Player Palette. This is the indicator of the

range of Live Frames.

Figure 4:4  The Live Frame Range

Home
Jump To First Live Frame

End
Jump To Last Live Frame

KEYBOARD SHORTCUT
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• Slide it from side to side to load a different range of frames into

RAM. If you did not load the maximum number of Live Frames

when you opened the clip, you can stretch as well as shrink the

range by click-dragging the end handle on the slider bar.

• Clicking on the arrow next to the Live Frames slider will load the

next range of frames in the clip.

• Click on the number on either side of the Live Frames slider to bring

up a dialog box to manually enter values for the range of frames

you would like to load. 

USING THE VIEWER TOOL

1. Select the Viewer tool from the Tool Palette.

2. Pick a small area you would like to view and make a selection

around it by clicking and dragging.

Figure 4:5  Selecting a View Region

3. Press Play. Only the part of the clip selected in the Viewer region

plays.

4. With the clip playing, click inside the Viewer region and drag it to a

different location.

V
Viewer

Shift-Drag
Add to Selection

Command-Drag
Subtract from Selection

KEYBOARD SHORTCUT
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Figure 4:6  Moving the Viewer Region

5. Hold down the Shift key and make another selection. Both View

regions now play.

Figure 4:7  Multiple View Regions Playing Simultaneously

The Viewer tool works in the same way as the other selection tools do;

Shift adds area to a selection, and Command deletes area from a

selection.

If you have made a preexisting selection with one of the other selection

tools (Marquee, Lasso, or Magic Wand), Commotion will keep that

selection in memory while you are using the Viewer tool to view the

footage.

6. Click Stop or hit the Space bar to halt playback.



 

TUTORIAL

 

com
m

otion

 

o
p

ening
 and

 p
laying

 clip
s

 

331

                  
RESIZING THE CLIP WINDOW

1. Use the Size Window handle in the bottom-right corner of the Clip

window to drag in and shrink the size of the view area.

2. Press Play.

3. Select the Hand tool from the Tool palette, or hold down the Control

key to temporarily select it. You can drag the clip around inside the

newly sized viewing area.

Figure 4:8  Moving the Clip

4. Return the window to its original size by clicking on the resize win-

dow button in the upper-right corner of the Clip window.

If you have multiple windows open, you can turn the windows that you

are not actively working on into thumbnails by clicking on the Collapse

Window Button located at the top of the scroll bar on the right-hand

side of the Clip Window.

Figure 4:9  Thumbnail

To return the thumbnail-sized image back to its original size, click any-

where within the small image.

5. Close the clip by clicking the Close button in the top left corner of

the window, by selecting Close from the File menu, or use the key-

board shortcut. If prompted to save changes, select Don’t Change.

H
Hand

Control
Quick-Activate Hand Tool

KEYBOARD SHORTCUT

W
Close Window

KEYBOARD SHORTCUT
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PREVIEWING A CLIP BEFORE OPENING IT

Commotion allows you to open clips as QuickTime movies and view

them just like you would in Apple’s MoviePlayer utility. This allows you

to quickly preview a clip without having to first load it into RAM. While

previewing it, you can select a specific range to load into Commotion

as Live Frames.

1. Press Command-O of select Open from the File menu to bring up

the Open dialog box.

2. Click the Open Movies as QuickTime Movies checkbox at the bot-

tom of the window.

3. Select piggybank.mov and press Open. The clip will appear in a

standard QuickTime window.

4. Shuttle back and forth by dragging the time indicator at the bottom

of the clip to evaluate the footage. Keep in mind that this clip is not

loaded into Commotion itself, and as such has no realtime playback

capabilities. This feature is for previewing clips only.

Figure 4:10  Evaluating the Footage

If you have a compressed video 

card such as a Media100 you can 

use this feature to take advantage 

of the realtime playback capabilities 

of the compressed signal, and then 

open a selection into Commotion 

for effects work.

POWER TIP!
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LOAD A PREVIEW INTO LIVE FRAMES

Once you have previewed your clip and know what frames you want to

load in to Commotion:

1. Move to the first frame you want to load, then hold down the Shift

key and click or drag to the last frame you want to load.

Figure 4:11  Selecting the Preview Range

2. Select Movie to Live Clip from the File menu.

3. The Load Frames dialog will appear, with the range of frames you

selected in the QuickTime window entered in the load frame fields.

Figure 4:12  The Preview Range Becomes the Live Frame Range

4. Press Cancel and close the QuickTime preview window.
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Lesson 2: Paint Tools Now that you are familiar with Commotion’s playback features, it’s time

to start painting. Commotion includes many familiar painting tools, as

well as several unique ones that are designed specifically for animation.

In this lesson you will learn how to use the following features:

• Painting an Animation

• Onion Skinning

• Revert

• AutoPaint to create a Write On effect

• AutoPaint Wiggle effect

• AutoPaint Stroke Only effect

ANIMATING

The following steps will guide you through the creation of a simple ani-

mation.

1. Choose Open from the File menu. The Open Dialog Box appears. 

2. If you just finished doing Lesson 1, the Open Movies as Quicktime

Movies button will still be checked. make sure this is unchecked

before proceeding.

3. Select the file Golden Gate.mov from the Lesson 2 folder. Click OK.

When the Load Frames dialog appears, try and load in at least 30

frames of the clip.

4. Select the Paintbrush tool by clicking on it in the toolbar or pressing

B on the keyboard.

5. Select a small brush with soft edges from the Brushes section of

the Tool Options palette. If this section isn’t visible, click on the tri-

angle along the left of the Tool Options palette to open it.

Command-O
Open

KEYBOARD SHORTCUT

B
Paintbrush

KEYBOARD SHORTCUT
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Figure 4:13  Selecting a Brush

6. Choose a yellow color from the Swatches section of the Color pal-

ette.

Figure 4:14  Select a Yellow Color

7. We’re going to paint in a bolt of lightning striking the Golden Gate

Bridge. Beginning on frame 1, paint a small line on the clip, like this:

Figure 4:15  Beginning to Paint
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8. Advance to the next frame and paint the line in a slightly different

position, so that the bolt of lightning begins to approach the bridge.

Repeat this process for a couple of frames.

9. At any time you can click the Play button (or press the Space bar) to

see the results of your work.

ONION SKINNING

When animating it is often useful to see an overlay of the frames pre-

ceding the one you are currently working on. Traditionally, animators

drew on semi-transparent paper to achieve this effect, called Onion

Skinning, for the semi-transparent layers of an onion. Commotion’s

Onion Skinning feature provides you with the digital equivalent of this

classic technique.

1. Turn on Onion Skinning by clicking on the Onion Skinning button

along the bottom of the Clip window. You can also select Onion

Skinning from the Mode menu, or press the O key.

2. Continue to draw your lightning bolt as it strikes the bridge’s tow-

ers. Use the previous frames to guide you as you animate.

Figure 4:16  Lightning Steps

3. When you are done, turn off Onion Skinning and playback the clip.

Page Up or Z
Reverse One Frame

Page Down or X
Forward One Frame

KEYBOARD SHORTCUT

O
Onion Skinning On/Off

KEYBOARD SHORTCUT
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Congratulations! You have just completed your first animation in Com-

motion.

REVERT

Before continuing, you may wish to return the clip to its original state.

Commotion’s Revert command allows you to quickly return one or

more frames to the way they were when they were last saved.

1. Select Revert from the File menu. The Revert Frames dialog will

appear. You have the choice of reverting all the frames of the cur-

rent clip, the frames in the Selection Range, or only the current

frame.

Figure 4:17  The Revert Dialog

2. Select All Frames and click Revert. There will be a short pause as

the clip is reverted, and then you will be ready to continue.

AUTOPAINT

Using the AutoPaint controls (located at the top of the Tool Options pal-

ette) you can record your paint strokes and play them back on multiple

frames.

Figure 4:18  Autopaint Controls

Command-R
Revert

KEYBOARD SHORTCUT
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CREATING A WRITE-ON EFFECT

First you will use AutoPaint to create a write-on, a commonly seen

effect in which an image, often handwriting or a logo, appears to write

itself onto the screen.

1. Select the Paintbrush tool.

2. In the Brush Control palette create a brush with the following set-

tings:

Figure 4:19  AutoPaint Brush 1

To adjust the Size, Feather, and Spacing values, use Commotion’s Rub

Text feature. Simply position your cursor over the name of the value you

want to adjust until the cursor becomes a double-sided horizontal

arrow. Drag right to increase the value, drag left to decrease it. You can

use Rub Text on most values in Commotion.

3. Click the Record button to begin recording.

4. Using the Paintbrush, write your name across the screen.

[
Figure 4:20  Writing Your Name

Shift-R
Record/Pause

Shift-P
Play Back on Current Frame

KEYBOARD SHORTCUT
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5. Click the record button again to pause recording. Any strokes made

when recording is paused will not be recorded.

Before playing the strokes back you will need to remove your signature

from the current frame. What we are going to do is have your name

write back over a range of frames. Writing your name on this frame was

simply to record the brush stroke, and we want to remove the writing

before we continue.

6. Once again, you will use the Revert command. Select Revert from

the File menu.

7. Select Current Frame and press Revert.

You are now ready to apply the write-on effect.

8. Click the Playback Animated button. Make sure you press the blue

button with the A on it and not the black button next to it.

The recorded strokes will play back over the current Selection Range.

The amount of the strokes played back will gradually increase on each

frame.

Figure 4:21  The Stroked Play Back

9. When AutoPaint playback has completed, Play the clip to see your

finished write-on.

10. Before continuing, select Revert and revert all frames.
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CREATING A WIGGLE EFFECT

AutoPaint can also be used to add motion to your breaststroke using

the Wiggle option. Wiggle slightly varies the recorded strokes each time

it applies them, creating a loose, animated look.

1. From the AutoPaint popup menu, select Wiggle Settings.

Figure 4:22  The AutoPaint Popup Menu

2. In the Wiggle Settings dialog, set both the vertical and horizontal

values to 4, then click OK

Figure 4:23  Wiggle Settings

3. Turn on Wiggle by clicking on the Wiggle checkbox in the AutoPaint

controls.

4. Click the Paint Over Range button. This is the black button next to

the blue Animate Play button you pressed earlier.

The recorded strokes will play back over the current Selection Range.

On each frame the recorded strokes will be played back in their entirety,

but varied slightly by the Wiggle.
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Figure 4:24  The Wiggle Effect

5. When AutoPaint playback has completed, Play the clip to see the

finished effect.

6. Before continuing, select Revert and revert all frames.

USING STROKE ONLY

Normally AutoPaint remembers all your tool settings when playing back

strokes. However, the Stroke Only feature allows you to playback

strokes using the current tool settings instead of the recorded ones.

You can change the color, brush size – even select an entirely different

tool.

1. Turn on Stroke Only by clicking on the Stroke Only checkbox. If

Wiggle is still checked, click it to turn it off.

2. Select the Paintbrush. This time, rather than select a brush and

then modify it in the Brush Control palette, we’re going to create a

realtime brush.

To create a realtime brush:

• Hold down Command and Option while dragging with the mouse.



TUTORIAL

com
m

otion
p

aint to
o

ls

342
• To add a feather (soft edge) to a brush you are making, release the

Command key while still holding down Option and drag toward the

center of the circle; the farther inward you drag, the greater the

feather added to the brush you create.

• Release the mouse button when the brush size and softness is set

how you want it

Give the brush a size of around 90, with a feather of around 40%

3. Change the Foreground color to a bright yellow, by using the sliders

in the Color Palette.

4. Click on the Paint Over Frame button. This is the button to the

immediate right of the Record button. It functions the same as the

Playback Range button, except it only plays back the brush stroke

to the current frame.

• The recorded strokes will play back onto the current frame, using

your new brush and color.

5. Select the Eraser tool, and create a realtime brush with a size of

around 32 and a feather around 20%.

6. When you selected the Eraser tool, the Eraser Options came up in

the Tool Options palette. Set the Eraser to Erase to Saved. This

causes the Eraser to function like a selective Revert by painting

directly from the Undo buffer, restoring their areas that you paint

back to the last version saved to disk.

7. Click on the Paint Over Frame button again. The recorded strokes

will play back again, this time using the Eraser and the smaller

brush.

Command-Option
Enter Mode/Set Size

Option
Set Feather

KEYBOARD SHORTCUT
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Figure 4:25  Erase To Saved

You’ve now completed the Painting tutorial, and have seen how Auto-

Paint can be used to achieve a nearly unlimited number of creative

effects. At this point you may want to spend some additional time

experimenting with AutoPaint and Commotion’s painting tools. When

you’re ready to move on, close this clip and proceed to the next lesson.
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Lesson 3: Clone Tools 
(1)

In addition to its painting tools, Commotion also provides unparalleled

tools for retouching moving imagery. In this lesson you will use one of

the most flexible of them, the SuperClone tool, to seamlessly remove a

large boat from a shot of an eagle flying over a lake.

Figure 4:26  Lesson 3

In this lesson you will learn how to use the following features:

• Clone

• SuperClone

• AutoPainting to Save Time

CLONE

First, let’s take a look at the Clone tool. Clone lets you paint in one area

of a frame using pixels from another area of the frame. To illustrate this,

do the following:

1. Open the eagle.mov file. If your system will allow, load the entire

clip into RAM.

2. Select the Clone tool from the Tool palette.

3. Option-click on the eagle’s beak. This defines that point as the

clone source; the area that you will be cloning from.

C
Clone

Option
Select Clone Region

KEYBOARD SHORTCUT
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4. Now begin painting elsewhere in the frame. Notice how the Clone

tool is applying pixels from the area you defined as your clone

source.

Figure 4:27  Cloning the Eagle

5. Before continuing, Revert this frame.

SUPERCLONE

Unique to the Commotion product line, the SuperClone tool is similar to

the Clone tool, with the added ability to clone from other frames in a

clip, or from other clips altogether.

1. Double-click on the SuperClone tool icon in the Tool menu. This will

select the SuperClone tool and open the Clone Source palette. This

is where you choose the file and frames you want to paint with.

Figure 4:28  The Clone Source Palette

S
Superclone

F1 through F4
Select Clone Source

KEYBOARD SHORTCUT
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2. Play the clip. Use the Current Frame slider in the Player palette to

scrub back and forth through the clip, noting exactly when the boat

in the background is visible and when it isn’t. Alternately, you can

use the Z and X keys to single-frame advance forward and back-

ward through the clip.

3. The first frame that the boat is visible is frame 5, and the last frame

it is visible is frame 17. The next frame, frame 18, is a clean plate, in

the sense that there is no boat in that frame. In order to paint out

our boat, will begin by painting on frame 5 with the boat-free pixels

from frame 18.

4. Go to frame 5. In the Clone Source palette, click on the frame num-

ber for the first Clone Source. This brings up the Clone Source dia-

log:

Figure 4:29  The Clone Source Dialog

5. Make sure that you are on frame 5. Enter frame 18 in the Clone

Source dialog, select Absolute, and click OK.

Once set, the SuperClone tool will maintain the same temporal (time)

relationship between your current frame and your source frame.

6. Using the X key, advance one frame to frame 6 while looking at the

Clone Source palette. Notice that the frame number for the Clone

Source has also advanced one frame to 19. The SuperClone source

Page Up or Z
Reverse One Frame

Page Down or X
Forward One Frame

KEYBOARD SHORTCUT
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will maintain the same temporal relationship, which in this case is a

13-frame offset between the source frame and the target frame.

7. Go back to frame 5. Create a new brush large enough to cover the

area between the wing and the top of the screen, setting the size of

the feathering to about 50% of the size of the brush.

Figure 4:30  Creating a Brush

8. Starting in the top right corner of the window, paint a single stroke

from right to left and back again across the top of the frame. 

Figure 4:31  Painting Out the Boat
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Figure 4:32  Painting the Wingtip Back from the Undo Buffer

9. Try to avoid the eagle’s wingtip. If you happen to erase part of the

wing, you can temporarily paint from the undo buffer by holding

down the Command key. Drag out a small brush, paint the wing

back in, and drag the large brush back out again.

The boat disappears seamlessly because you are painting over the

boat pixels in frame 5 with the water pixels from frame 18. While you

could perform this retouching frame by frame, let’s take a look at a

much easier method.

SAVING TIME WITH AUTOPAINT

You’ve already used AutoPaint to create painting effects; now you will

see how it can be used to save time. To finish this shot you’ll only need

to paint out the boat on one frame —AutoPaint will do the rest.

1. Advance to frame 6.

2. Before we record our stroke, make sure that any previous AutoPaint

data has been cleared from the brush buffer. If there is a previous

brush stroke still in memory, the trash can icon in the AutoPaint pal-

ette will be active. When pressed the brush buffer clears and the

trash can is grayed out.

Figure 4:33  Clearing the Brush Buffer

Command-Paint
Paint From Undo Buffer

KEYBOARD SHORTCUT
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3. With the brush buffer clear, click on the Record button.

4. Using the SuperClone tool, paint a single stroke from right to left

and back again, just like you did for frame 5. 

Figure 4:34  Painting Out the Boat

5. Click on the Stop button once the stroke is complete.

6. To paint out the boat, you’ll need to play the stroke back over the

remaining frames where the boat appears. To do this we will set the

Selection Range slider in the Player Palette to range from frame 7 to

frame 18.

7. Advance to frame 7 and press the minus key (“-”). This will set

frame 7 as the in frame of the Selection Range.

8. Set the out frame by clicking and dragging the right point of the

Selection Range slider to frame 18. You are now ready to automati-

cally paint out the boat from these frames. 

Figure 4:35  The Selection Range
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9. Click on the Paint Over Range button in the AutoPaint panel and

watch Commotion do the rest!

10. When the AutoPaint playback is finished, play the clip to preview

the shot.

Figure 4:36  The Boat Wake

11. In the first four frames of the clip you can see the white wake from

the boat. Use the SuperClone or Clone tool to paint out the wake

and complete the shot.
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Lesson 4: Clone Tools 
(2)

The footage for this section of the tutorial was based on a commercial

on which Commotion was used. When the initial storyboards were pre-

sented for the commercial, they featured a good idea. However, they

were in need of pizzazz. The director of the commercial decided to use

abstract, changeable backgrounds which flowed continuously through-

out the spot and helped to strengthen the ad’s message. A variety of

richly-textured, unusual objects were filmed, of which psychedelic

undulation pin cushions, desiccated plots of earth, and wide-eyed

wedding dolls were just a few. 

Because of the organic, amorphous nature of the backgrounds, experi-

mentation was essential. Continual changes and adjustments to the

backgrounds were required up until the very end of the production

cycle. Commotion, with its uncompressed realtime playback on the

desktop made this process possible as well as painless.

Commotion’s paint over time features were also used to perfect various

shots in the spot. One of the backgrounds used in the final commercial

consisted of rippling concentric rings of water. Due to the way the shot

was lit, the drop of water which caused the rings translated into highly

visible white streaks and splashes. With Commotion, the digital artist

was able to quickly and efficiently paint out the water droplet over a

series of frames. In the same way, the process of removing dirt and ren-

dering artifacts from the various backgrounds was also effectively per-

formed using Commotion.

This tutorial expands upon the skills learned in Lesson 3. In this lesson

you will learn and use the following features:

• Super Clone

• Wire Removal Tool

• Playback
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WATER RINGS

To preview the final footage:

1. Open the movie file water-cleaned.mov.

If you do not have enough RAM to load all the frames into the Live

Frames, use the scale popup menu to scale it to a small enough size so

that all of the frames can be loaded.

2. Play the footage. Note the way the water ripples look without high-

lights.

3. Stop the playback and close the window.

REMOVING THE DROPLET

1. Open the file water-ripples.mov from the CD.

2. There are 50 frames in this clip. For the purpose of this exercise you

really only need frames 1 through 20, but try and load as many

frames as you can. Leave all of the other settings as they are and

click OK.

WIRE REMOVAL TOOL

The first part of the film that you will be cleaning up is frames 2 through

5, the falling drops of water that appear bright white on the film. We will

use the Wire Removal tool to get rid of some of these long streaks.

1. Go to frame 4. There is a white streak going down the middle of the

screen where the water droplet is in motion.

2. Click on the Wire Removal Tool in the Tools palette type, or type Q

on the keyboard to activate it. 

3. In the Wire Removal Tool options panel, located in the Tool Options

palette, set the width to 10. Leave all the other values as they are.

The Wire Removal tool operates like the Line tool found in most draw-

ing packages; click to set a point, click-drag out a line, and release the
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mouse button to create the second point. For precise line placerment,

hold down Shift while dragging to turn the cursor to a crosshair; press

Caps Lock and it will stay that way.

4. Position the tool at the top of the streak. Drag out a line down its

length, and release the mouse. Like magic, the streak simply disap-

pears!

Figure 4:37  The Wire Removal Tool In Action

5. Do the same thing for the other two streaks in frame 4, then do

frames 1-3 and 5.

6. Frame 6 is the first splash frame. You will still use the Wire Removal

Tool for the streaks in this frame, but not for the splash itself; Super-

Clone will take care of that. Apply the wire removal tool to all

streaks in frames 6-14. It is extremely important that you get rid of

every streak, no matter how small.

7. Preview your work.

USING SUPERCLONE

We will be using the SuperClone tool to paint out the highlights from the

water ripple, all the while leaving the ripple itself completely intact.
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Before you begin, scrub through the first few frames of the clip. Notice

now that the first 5 frames are completely clear. Until frame 6, (the first

frame with a splash,) we have 5 frames to use as a clean clone source.

1. Go to frame 6.

2. Select the SuperClone tool by clicking it’s icon in the Tool palette,

or press S on your keyboard.

3. Select a small brush from the brush palette, or create a Realtime

Brush.

Figure 4:38  Creating the SuperClone Brush

You will be painting out drops of water that are several pixels wide, so

ensure that your brush is not too small, or it will increase the time it

takes to paint out the flaws.

Before we paint, scrub through the length of the clip and notice the way

the highlights move. Frames 6-10 have the actual water splash in them.

Around frame 11 the highlight essentially splits into two pieces. In the

next few steps we will remove the outer highlight.

4. As noted earlier, the first 5 frames can be used as clean frames.

Make sure you are on frame 6. Open the Clone Source palette, and

set your clone source to be frame 1. Position your brush over the

outer highlight and paint it out, as in Figure 4:39

S
Superclone

KEYBOARD SHORTCUT
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Figure 4:39  Before and After

5. Frame 7 doesn’t really have two separate highlights so skip it and

go to frame 8. Paint out the outer highlight in frames 8 through 18.

6. Preview your work.

This is a tricky clip to touch up because of the motion of the water

rings. There is no exact way to do it. It will most likely take you a few

times to get it right.

Keep in mind as you paint that in order to preserve the integrity of the

water rings you are going to want to capture the different shades of

blue. It is easiest to do this using short strokes (or even single mouse

clicks) and resampling the area being used as the source. 

If you make a mistake or carry a stroke too far there is no need to undo

all the way from the last time you picked up your brush. Hold down the

Command key and paint over the area you wish to replace. This allows

you paint directly from the undo buffer.

USING CLONE SOURCE OVERLAY

Now comes the really tricky part. We now have to remove the highlights

from the splash area itself. Rather than constantly trying to precisely

match up our clone brush strokes to the shape of the splash and rings,

we’re going to use Commotion’s Clone Source Overlay feature to visu-

ally set an offset for our SuperClone brush.

1. Go to frame 18 and create a medium-to-small realtime brush. Your

brush should be around 50 pixels wide and have a lot of Feather, at

Option-Shift
Access/Reposition Clone Source Overlay

Option-O
Toggles Overlay On and Off

Arrow Keys
Nudge X/Y Offset 1 Pixel

Shift-Arrow Keys
Nudge X/Y Offset 10 Pixels

KEYBOARD SHORTCUT
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least 60%.

2. Click on the frame number in the Clone Source palette and set an

Absolute value of 20. We are now going to paint in frame 18 with

pixels from frame 20.

3. In the top right corner of the Clip window, click the Clone Source

Overlay button. This feature adds a reduced opacity view of your

clone source (frame 20) over your current frame (frame 18.) Figure

4:40 shows Frame 18 before and after turning on Clone Source

Overlay.

Figure 4:40  Frame 18 Without/With Clone Source Overlay

To set an offset, you have three options:

• Hold down the Shift key, then click and drag over the image. This

will interactively set the X/Y offset for your source.

• Use the arrow keys to nudge the source by 1 pixel at a time, or

Shift+arrow to nudge by 10 pixels at a time. 

• Manually set the X/Y offset by clicking on one of the X/Y values in

the clone source palette and entering values in the following dialog:

Figure 4:41  The Close Source Offset Dialog
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4. Use the first option and interactively set your offset. Hold down

Option and Shift and drag the overlay down and to the left, so that

the outer ring of the ripple on frame 20 lines up with the highlighted

ring in frame 18.

If you look at the Clone Source palette your X/Y offset should be some-

where in the neighborhood of -1,32.

What we now have is a clean part of the ripple from frame 16 directly

over the highlighted ripple on frame 18. Now we just have to paint.

5. Turn off Clone Source Overlay, and simply paint right over the top of

the highlight.

Figure 4:42  Before and After, Frame 18

Because we could see an overlay of our clone source we were able to

perfectly line up the clean ripple from frame 20 with the highlighted rip-

ple in frame 18.

FINISHING

Using Clone Source Overlay to change your clone offset as needed,

paint out the rest of the highlights and complete the project. When fin-

ished, compare your work to that found in water-cleaned.mov
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Lesson 5: Advanced 
Write-On Effects

Commotion’s AutoPaint feature, combined with the SuperClone tool,

enables the quick creation of write-on effects. The write-on effect is

often used in broadcast commercials and film titles. 

In this lesson you will learn and use the following features:

• SuperClone

• AutoPaint

CREATING THE TEXT

1. Start by creating a new document in Adobe Photoshop (or any

other image editor with a text tool). Make the background white and

set the dimensions to the same resolution as your final movie. Use

the text tool to type out the word(s) you want to write over time.

This text should be black. If you like, you can use the file text.pict,

located in the Lesson 5 folder.

Figure 4:43  The Text

2. On the white background layer with the black text, Select All and

choose Copy from the Edit menu. In the Channels palette, create a

new channel (Alpha 1) and Paste in the information from the clip-

board. Save this file as a PICT file.
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Figure 4:44  The Alpha Channel

Next you need to choose what type of Write-On effect you want to cre-

ate. You can either write this text on as black text or select another

color or moving video footage. Or, you can simply write it on over time

against white, and use it as a lumikey in another application. 

WRITING ON BLACK TEXT IN COMMOTION

1. Open the file goldengate.mov. This will be the background image

that the write-on effect will be applied to.

2. Since we’re going to write-on the image in the PICT file over the

first 30 frames of this clip, set the Selection Range from 0-30.

3. Open the one frame PICT file of the text. If you like, click the Col-

lapse Window button to minimize the PICT file, as we only need it

as a source file.

Figure 4:45  PICT Window

4. With goldengate.mov selected in the foreground, set the Super-

Clone tool to clone from the text image.
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Figure 4:46  The Clone Source Palette

When you clone, you will be cloning in information from the text file,

including the white background.

5. Set the transfer mode to Darker in the Tool Options palette. This will

allow the paintbrush to treat the white background as a transpar-

ency and paint on only the black text.

Figure 4:47  Selecting Darker

6. Turn on the Clone Source Overlay. Hold down the Option and Shift

keys to offset the position of the overlay.

Option-Shift
Access/Reposition Clone Source Overlay

Option-O
Toggles Overlay On and Off

Arrow Keys
Nudge X/Y Offset 1 Pixel

Shift-Arrow Keys
Nudge X/Y Offset 10 Pixels

KEYBOARD SHORTCUT
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Figure 4:48  The Clone Source Over the Golden Gate Clip

You can adjust the opacity of the overlay in the Tool Options palette.

7. To begin recording the write-on effect, choose a soft edged brush

that will cover the thickest part of the text and click on the Auto-

Paint Record button in the Tool Options palette. Trace over the text

with the SuperClone tool. When you finish, press the Stop button to

stop recording, then Revert the current frame.

8. Click on the Playback Animated button to paint the text on over

time. 

Figure 4:49  Playing Back the Effect
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TECHNIQUE OPTIONS

Writing On Color Text in Commotion:

Use the same technique as mentioned above, except create the Write-

On effect into the alpha channel of a new Commotion file. Make the

RGB of this new Commotion file the color of the desired text. For this to

work correctly, the black text must be contained in the Alpha Channel

of the original PICT file. After applying the write-on effect to the Alpha

Channel, composite this clip on top of a background to produce the

final colored write-on effect.

Writing On Text of Video Footage in Commotion

Use the same technique as writing on color text, except instead of writ-

ing it into the alpha of a new clip, animate it into the alpha of the video

footage you want to write on. For example, writing the text on over time

into the alpha of fire footage will produce text made out of animated

fire. 

Writing On Text To Use As A Lumi-Key in Another Application:

Simply write on the black text over time into a new Commotion docu-

ment. Save the file out and use it as a lumikey in your compositing

application. This provides a lot more flexibility, since the matte can eas-

ily be controlled for feathering, drop shadows, glows, etc. 
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Lesson 6: Painting on 
Frames & Fields

Commotion has a number of features to support field based operations

for both NTSC and PAL video clips, including realtime painting on field

based material, allowing you to quickly perform field-accurate painting

without rendering.

What are Fields and why do they occur?

Television monitors are interlaced, meaning that every frame is divided

into two groups of horizontal lines – odd and even – called fields. Unlike

computer monitors, which draw every line one after the other, television

monitors draw the lines in one field first, and then draw the lines in the

second field. Thus, a 30 frame per second NTSC broadcast signal

actually contains 60 fields per second.

Video as a source was initially criticized as being too clean because it

does not capture the natural motion blur that occurs on film. To com-

pensate for this, video cameras capture motion on each field in a simi-

lar manner to how a film camera would capture motion on each frame.

In this manner much of the smooth motion lost in video is recaptured

with fields.

Because motion occurs between individual fields in video footage, it is

often necessary to work with individual fields when creating source for

broadcast use. The following lesson will show you how to use Commo-

tion to paint on fields.

In this lesson you will use Commotion’s Field Mode capability to quickly

and accurately paint on field based footage. You will use the following

features:

• Field Mode

• Field Blending
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FIELD MODE

1. Open the file tshirt.mov from the Lesson 6 folder. Load a portion of

the clip.

Figure 4:50  tshirt.mov

2. Play the clip.

3. Use the Z and X keys to step through the first few frames to exam-

ine the blurring around the rapper’s arms and the lettering on his T-

shirt.

Figure 4:51  Interlaced Fields

This clip was shot with a digital video camera. The camera recorded 60

fields of information representing 60 distinct moments in time. These
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fields are interlaced together in the video signal, causing a tearing or

blurring effect, as each frame contains two different moments in time.

Figure 4:52  The Upper Field and The Lower Field

PAINTING ON FIELDS

Because the words Porn Star are not desired for the final clip we will

need to paint out the words from the T-Shirt in all 90 frames of the shot.

However, the interlaced fields make accurate painting impossible.

Figure 4:53  Porn Star Interlaced

In order to paint on this rapidly moving image we must split the frame

into fields. Commotion makes this possible with the Field Mode.

1. Click the Field Mode button at the bottom of the clip window or use

the keyboard shortcut.

When in field mode, Commotion duplicates the current field so that the

image is still full-height in the clip window. 

/
Toggle Field and Frame Mode

KEYBOARD SHORTCUT
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Figure 4:54  Porn Star Upper Field

2. Play the clip in field mode. The playback speed will be considerably

slower due to the full-height adjustment for each field. On each new

field, Commotion is de-interlacing and field doubling the image on

the fly!

Now as you single-frame advance through the clip you will see the

upper field and then the lower field—indicated by the upper/lower field

indicator in the Field Mode button.

While in Field Mode, advancing forward/backwards will advance one

field, instead of a whole frame. Clicking on the field indicator will toggle

through the modes. 

While in field mode, all painting operations will only affect the current

field. In Figure 4:55, the two images on the left show two brush strokes

applied to the upper and lower field, respectively. The image on the

right shows those fields combined into a single frame. Note that half

the paint information in each field is discarded when interlaced. In the

example below, the only place where there is a “solid” paint stroke is

where the lines intersect.

Figure 4:55  Upper, Lower, and Interlaced Example

3. Select the T-Shirt color using the eyedropper, then select the Paint-

brush tool, and begin painting out the words Porn Star from the

field.

Page Up or Z
Reverse One Frame

Page Down or X
Forward One Frame

KEYBOARD SHORTCUT

I
Eyedropper

Option-Click
Quick-Access Eyedropper

This works for all tools except 
Rotospline, Clone, and SuperClone

KEYBOARD SHORTCUT
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Figure 4:56  Painting Out Porn Star

As you move through the clip painting on the T-Shirt, you will need to

paint areas that are in shadow and ripples on the t-shirt which are

slightly darker than the white color. Try to use a limited palette of colors

(3-4 shades) so that you don’t introduce unnecessary chatter between

frames.

Figure 4:57  Shadows and Light

4. Remember that all of Commotion’s painting tools work while in

Field Mode, so you may choose to Clone or SuperClone certain

frames. 

5. Painting out the word Porn Star in the entire 90 frames shouldn’t

take more than 1 hour. If you would like to see the finished shot,

open the tshirt-painted.mov file from the Lesson 6 folder. If you

move through the painted file, you will notice that a relatively low

precision level is all that is necessary to paint out the image. This is

because when the image is shown on an NTSC monitor, the small

tonal differences between whites and shadows are not evident at

all.

When in field mode, the field dominance determines the order in which

the fields play back (whether the upper or lower field comes first in
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time). The field dominance can be changed from the Display Prefer-

ences window.

(For more information see Display Preferences on page 89.)

INTERLACE/DEINTERLACE

The Interlace/Deinterlace calculation (under the Calculate menu) will

take a 30/25 fps frame based clip and generate a 60/50fps field based

clip so that you can perform rotoscope work or composite in a 60fps

mode; when you are done, the same filter will reinterlace the image

back to 30/25 fps. This feature does one of two things:

• rips apart a clip’s fields and creates a new clip that is twice as long

• takes a clip that is field based and brings it back to interlaced mode

(half as long). 

(For more information see Interlace/Deinterlace on page 115.)

FIELD BLENDING

Field Blending can be used to actually soften the differences from two

fields or eliminate a field altogether.

When selected, the filter will either double fields by duplication or blend

two fields together by interpolation, effectively removing the 60 field

time base permanently.

Figure 4:58  The Field Blending Dialog
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The advantage of using this filter is that you simplify your clip and limit

your timebase to 30fps. If you were to apply this filter to the T-Shirt clip,

you would have half as many frames to paint on.

The disadvantage is that it eliminates half the temporal resolution of

your clip – working on all 60 fields will yield a much higher quality result.

(For more information see Field Blending on page 118.)

REVERSE FIELD DOMINANCE 

Reverse Field Dominance is a quick solution to swapping field domi-

nance on a clip. Field dominance settings may vary between your cam-

era, capture method, and off-line editor. This filter will quickly reverse

the order of the fields to match the equipment you are using. This is

accomplished by taking the selected in-out frame range and reversing

the even and odd (upper/lower) fields within each frame.

(For more information see Reverse Field Order on page 119.)
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Lesson 7: The 
Timeline 

This main purpose of this lesson is to provide you with a general over-

view of the Timeline. Since this is a new feature to 2.0 we have not

made this lesson incredibly detailed, as users coming from previous

versions can use it to quickly acquaint themselves with this new fea-

ture.

In this tutorial you will create a matte with Rotosplines and apply a filter

effect to a clip. Both these topics are covered in greater detail in later

lessons.

In this lesson you will learn how to use the following features:

• The Timeline

• The Rotospline Palette

• Rendering a Rotospline Matte

• Filter Effects

In this lesson, we will add a Photon Torpedo being shot through the

Golden Gate Bridge. To create the torpedo effect we will use Knoll Lens

Flare Pro, a plug-in sold separately by Puffin Designs. If you do not

already own this plug-in, you can use the demo version found on the

2.0 CD. You can get more information on Knoll Lens Flare Fro and other

Puffin Designs products by visiting our website at http://www.puffinde-

signs.com.

SET UP THE SCENE

1. Open up 30 frames of the QuickTime file Golden Gate.mov from the

http://www.puffindesigns.com
http://www.puffindesigns.com
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Lesson 7 folder.

Figure 4:59  Golden Gate.mov

In order to create an effect later in the tutorial we need a matte of the

front half of the bridge, and to do this we’ll use Rotosplines. We’ve cre-

ated the splines for you in this instance; you’ll learn about creating

mattes with splines in a later lesson.

2. Open the Rotospline palette by double-clicking its icon in the Tool

palette or by pressing F7.

3. Load in the Rotospline file Golden Gate.splines from the Lesson 7

folder by selecting Load All Paths from the Rotospline popup menu

by pressing the button in the top right corner of the Rotospline pal-

ette.

P
Pen

F7
Show/Hide Rotospline Palette

F12
Load All Paths

KEYBOARD SHORTCUT
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Figure 4:60  Bridge With Paths

The splines appear in both the Rotospline palette and the Clip window.

4. To preview the matte press the Preview button in the Rotospline

palette. To end the preview click anywhere in the clip window.

Figure 4:61  Previewing the Matte

5. To render the matte to the alpha of current clip press the Render

button located in the Rotospline palette.

6. When the Render Options for Splines dialog appears, select To

Alpha of Current Clip and press OK.

F15
Preview Splines

Shift-F15
Spline Preview Options

KEYBOARD SHORTCUT
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Figure 4:62  Render Options for Splines

ADD THE FLARE

1. In the Filter menu, scroll down to the Knoll menu and select Lens

Flare Pro. The Timeline window appears.

Figure 4:63  The Knoll Lens Flare Pro Timeline Window

The only difference between Knoll Lens Flare Pro and the Demo version

is the demo will preview and render with green lines through the clip.
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Figure 4:64  Knoll Demo Preview Window

2. If it is not already there, drag the Current Time Marker, (the vertical

red line,) to frame 1.

3. Leave all the settings at the top of the timeline at their defaults.

Next to the words Lens Flare Pro press the Options button.

4. The Lens Editor appears.

The Options button will bring up options for any plug-in with a built-in

editor or options window.

Figure 4:65  Lens Flare Pro Lens Editor

5. In the Lens Editor, choose Load. An Open dialog appears. Locate

the file Photon Torpedo.lfp in the Lesson 7 folder and click OK. Your

flare changes to look like Figure 4:66
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Figure 4:66  Photon Torpedo is Added

6. In the Timeline, hold down the Option key and position your cursor

over the Brightness parameter until it becomes a double sided

arrow. Click and drag back and forth to set the Brightness value to

about 45.

Figure 4:67  Adjusting the Brightness

7. Set the Scale value to about 0.40.

8. Position your cursor over the Light Source Location value until it

becomes a set of crossed arrows. Option-drag to the upper left part

of the screen. Set the values to approximately 3, 11.

9. Set keyframes for the parameters Brightness, Scale, Light Source

Location, and Angle on frame 1. To set the keyframes, click on the

white circle at the end of the property.

Figure 4:68  Setting the Keyframes

10. Drag the Current Time Marker to frame 30.

11. Option-drag the Light Source Location until it ends up in approxi-

mately the position 479, 225. A keyframe is automatically created.

If you hold down Option while drag-
ging, you will see a realtime update 
in your preview window.

POWER TIP!
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Figure 4:69  Keyframes are Automatically Created

12. Set the Angle parameter to 30. This will make the torpedo spin as it

moves.

13. Click the Play button underneath the Preview Window to view the

animation.

Figure 4:70  Previewing the Effect

Notice that the flare travels in front of the bridge. We want it to appear

as if it is going behind the bridge.

14. To have the flare be obscured by the bridge, we need to set up an

Obscuration Layer. Under the Obscuration Layer pull down, choose

the Golden Gate.mov. 

15. Press Play again to preview the effect. Now notice how the flare is

obscured as it is passes over the area masked in the alpha channel,

thus giving the appearance of going behind the bridge.

Figure 4:71  The Torpedo is Obscured

16. Hit OK to render this effect into the clip.
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Lesson 8: Motion 
Tracking (1)

Motion Tracking provides Commotion users with several new produc-

tion techniques for creating mattes and automating paint work. Com-

motion can have an unlimited number of trackers. Each tracker is a

search window that will follow a region of your image as it moves

through a frame. Bear in mind that motion in a scene can be objects

moving or camera movement which creates apparent motion in this

section:

For this tutorial we will track several objects in the Boat Shake movie,

and then use the motion tracker data to:

• Stabilize the camera shake in the shot

• Apply the motion to rotosplines to automate rotoscoping

• AutoPaint strokes to automate some paint work

• Reintroduce the camera shake to the shot.

In this lesson you will learn how to use the following features:

• Motion Tracking

• Stabilizing a Shot

• Applying Track Data to Rotosplines

• Applying Track Data to AutoPaint

• Destabilizing a Shot

ANALYZING THE BOAT SHAKE MOVIE

1. Open the file boatshake.mov. It is not necessary to load the entire

frame range of the clip, but if you have enough RAM, load all 60

frames. For the tutorial we will assume you have all frames loaded.



TUTORIAL

com
m

otion
m

o
tio

n tracking
 (1)

378
Figure 4:72  The Boat shake Clip

2. Play the clip. Notice that the camera is moving up and down ever

so slightly. This slight drift from the hand-held camera will greatly

complicate any rotoscoping or paint work. To create a matte for the

boat, it would require several keyframes to animate a rotospline to

match the movement.

TRACKING THE WHITE DOCK POST

Now, we will use the motion tracker to analyze the camera movement.

1. Open the Motion Tracker palette. The palette can be reached by

double clicking on the Motion Tracker tool or by selecting the

Motion Tracker from the Windows menu.

2. Create a new motion tracker by clicking on the New Motion Tracker

button in the bottom right corner of the Motion Tracker palette.

3. Cue the clip to frame 1. When you set up a tracker, make sure you

are at the beginning or end of the frame range that you wish to

track.

T
Motion Tracker

F7
Show/Hide Rotospline Palette

KEYBOARD SHORTCUT
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4. Move the Track Target and Track Region markers to select the area

to track.

Figure 4:73  Selecting the Track Object

The Track Target is the inner rectangle and represents the pixel pattern

that the tracker will search for. The Track Region is the outer rectangle

and represents the region to search for on each frame.

Picking the best Track Target and Region is the trick to good motion

tracking. Here are some tips:

• Track Targets should be high contrast areas of the image that stay

relatively constant in size and appearance so that they can be rec-

ognized as they move. If you have problems tracking an object, try

changing the size and position of your Track Target.

• When possible, try not to pick objects that are obscured halfway

through a shot or that move offscreen. Commotion does have fea-

tures to track objects like this, but it will require additional steps.

(For more information see The Motion Tracker on page 270.)

• Track Regions should be just large enough to include the entire

range of possible motion from frame to frame since the size of the

track region greatly affects the performance of the motion tracking.

The Track Region is a RELATIVE 

search area; this means that if an 

object (black dot) is moving across 

screen from left to right over a 

series of 100 frames, the Track 

Region only needs to be as big as 

the greatest movement from one 

frame to the next, not as big as the 

entire frame.

POWER TIP!
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5. Place the Track Target over the white tip of the post on the dock.

This area has very discernible contrast with the background, and

remains in clear view throughout the shot.

6. Fine tune the positioning by turning on tracker magnification. You

can activate the magnification by hitting 1-5 on the keyboard while

the Tracker Tool is selected, or by selecting a magnification from

the Tracker Zoom popup in the lower left corner of the Tracker Pal-

ette.

Figure 4:74  Fine Tuning the Track Target

While the Tracker Target is magnified, it is easier to evaluate the pixels

that you are targeting for your track. You can reposition or resize the

Track Target while magnification is turned on. You can quickly toggle

between a magnified view by pressing 1-5 on the keyboard.

7. Once you are satisfied with the Track Target, hit the Track Button in

the Tracker Floating Palette. The Motion Tracking dialog appears.

1
1:1 Magnification

2
2:1 Magnification

3
4:1 Magnification
4
8:1 Magnification

5
16:1 Magnification

KEYBOARD SHORTCUT
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Figure 4:75  The Motion Tracking Dialog

8. There are many settings to control how the motion tracking will take

place. These controls allow you to fine tune how Commotion ana-

lyzes the motion in the image. Make sure the SubPixel Accuracy is

set to 1/16th and hit OK to begin tracking.

(For more information see Motion Tracking Dialog on page 276.)

9. Once the track is complete, a crosshair will appear along with a

path indicating the motion of the dock post. For a better view, zoom

in on the region where the track took place.

Figure 4:76  Zoomed in on the Tracked Point

You can toggle the path and crosshair visibility by clicking the C and P

settings in the Motion Trackers palette. For playback, turn off the Path



TUTORIAL

com
m

otion
m

o
tio

n tracking
 (1)

382
(P) and hit play. You will see a crosshair follow the post around as it

moves in the frame.

10. Commotion’s realtime performance allows you to immediately see

any slippage or misalignment in your track. If the tracker had gone

off target, you can cue to the frame and either re-track the region or

manually correct the tracker by manipulating the path. For example,

turn on the Path (P), and select any point in the tracker’s path. You

can move this point or multiple points around, or select a point and

hit delete to remove the points and have Commotion interpolate the

motion for a series of frames.

11. Zoom out to full resolution and continue analyzing the tracker data

at full speed.

APPLYING TRACKER DATA TO ROTOSPLINES

Now we can use the tracked data to automate the creation of a matte

for the boat.

1. Load the boat.spline rotospline from the tutorial disk. Open the

Rotospline palette by double clicking on the Rotospline tool and

select Load All Paths from the popup menu in the top right corner

of the palette. Alternately, you can create your own new spline by

drawing a rotospline around the boat.

Figure 4:77  The Boat Rotospline

Command-\
Zoom Out to 100%

KEYBOARD SHORTCUT
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2. Play the clip. Notice that while the boat rotospline matches the boat

perfectly on frame 1, the boat slides about uncontrollably beneath

the spline throughout the rest of the shot.

3. Select the spline by clicking on it’s name in the Rotospline palette,

then apply the motion tracker data to the boat spline by pressing

the Apply Tracker button. 

Figure 4:78  The Apply Tracker Data Dialog

In the Apply Tracker Data dialog, indicate whether you wish to apply the

tracker data to the Current Selected Point(s) or to the Entire Spline (or

multiple splines if more than one spline is selected). Choose Entire

Spline and hit OK.

4. Select the tracker you want to use from the popup menu. (There is

only one selection, Track 0.) The default settings assume you want

to apply both X and Y position movement to the spline.

If you had a second tracker selected, you could also choose to have

rotation and scale information applied to your spline. (This will be cov-

ered in the Lesson 8.)
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Figure 4:79  Apply Data to Curves

5. Play the clip. Notice that the boat rotospline is now in synch with

the camera movement. You just saved yourself a boat-load of time

creating a matte.

STABILIZE THE SHOT

Now we will apply the motion tracked data to remove the camera

movement. By stabilizing the shot, we will remove the motion in the

shot, effectively making it appear as if it was shot with a locked down

camera. This will allow us to alter the shot much more readily. Then,

once we have completed the work on the shot, we will reintroduce the

camera motion.

1. Play back the footage again and notice how the white post moves

back and forth in the shot. Turn off the Rotospline and Tracker visi-

bility by clicking on the eyeball icons.

2. Click the Stabilize button in the Motion Tracker palette. This brings

up the Stabilize Dialog.
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Figure 4:80  The Stabilize Dialog

3. Select the tracker(s) and type of stabilization. Since the camera was

mostly moving up/down and left/right (X,Y) and not rotating or

zooming in or out, one tracked point is all we will need to stabilize

this shot. 

4. Since we are going to eventually add the stabilized motion back

into the shot, check Wrap Edges. This will wrap the edge pixels

around to the opposite side when they are pushed outside the limits

of the clip.

Stabilization works by applying the inverse values of the tracked data

to it’s position. When we destabilize the shot we will want to move the

image in the opposite manner to when we stabilized it; essentially we

will be applying the inverse of the inverse, or simply reintroducing the

motion. By having the edge pixels wrap around we won’t lose any data

from the edges of the clip.

5. Hit OK and wait while Commotion renders the stabilization.

6. Play back the footage to analyze the quality of the tracked data. If

the tracked data is accurate, the white post should be perfectly still.

You can zoom in slightly and use the Viewer tool to select a viewing

region just around the post. When you play the footage the only

thing moving should be the grain from the film.
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ALTERNATIVE STABILIZATION METHODS

Commotion provides you with two alternative methods of stabilization.

Export the Motion Tracker data to Adobe After Effects:

Most artists will want to use motion tracker data from Commotion in a

variety of ways. While Commotion offers image stabilization (as we’ve

just seen), it can be very useful to integrate motion tracked data for sta-

bilization and further compositing directly within After Effects. After sta-

bilizing within Commotion and analyzing the results, you can easily

export the data to After Effects.

1. Select the tracker to export to After Effects.

2. Select the Export AE Data to Clipboard command from the Motion

Trackers popup menu in the upper right corner of the palette.

3. Select the type of data you wish to export and hit OK. The keyframe

information is now copied to the clipboard. You can paste this infor-

mation directly into an After Effects layer within a composite, or you

paste it to the Notepad or a Simpletext document for temporary

storage.

Alternately, you can save tracker data in After Effects format which will

simply create a text file containing the information.

(For more information see Export AE Data To Clipboard on page 286.)

Use one of Commotion’s Stabilize Filters:

Commotion comes with three different filters with which you can use

motion track data to position another image:

• Corner Pin

• Match Move

• Stabilize
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We will be using the Stabilize filter later in this exercise to reintroduce

the camera motion.

(For more information see The Stabilize Menu on page 188.)

PAINT OUT THE SEAGULL

We will now use motion tracker data to automate some paint work and

then remove the seagull which is seen flying through this shot.

1. Track the seagull using a new motion tracker. If you need help, refer

to see Tracking the White Dock Post on page 378. to review the

steps we used to track the white post. 

Alternately, you can load a precooked tracker set by loading the

boat.shake.trackers file from the tutorial CD. To load a tracker, select

Load All Trackers from the Motion Tracker popup menu.

You should now have a set of tracker data following the seagull’s

motion through the frame.

Figure 4:81  The Tracked Seagull

2. Create a clean plate on frame 1. The goal is to remove the seagull

from frame 1, so that we can then use it as a bird-free clone source

with which we can paint out the seagull on all subsequent frames.
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The easiest way to clean up the bird on frame 1 is to use the Super-

Clone brush and to clone from frame 15.You should end up with a

frame 1 that looks like Figure 4:82.

Figure 4:82  The Clean Plate

Next we’ll record a brush stroke using SuperClone, then apply tracker

data to it to automatically paint out the bird on frame 2.

3. Cue to frame 2. Then set the SuperClone Brush settings to be

locked to frame 1. (Frame 1 is now our clean plate.)

4. From the Autopaint panel in the Tool Options palette, turn on

recording by clicking on the record button. (If you’ve been recording

any brush-strokes prior to this, make sure you delete the brush

buffer by pressing the trash can icon in the AutoPaint area.)

Once recording, make a brush stroke with the SuperClone brush to

remove the seagull from frame 2. Make sure the stroke is relatively big

and covers an area slightly bigger than the bird in frame 2 (as the bird

moves, her wingspan increases. 

5. Have Commotion automatically repeat the brush stroke following

the tracked seagull by pressing the Play Range With Tracker Data

button, (the button underneath the Play Range button in the Tool

Options palette.) Commotion will apply the brush strokes that are in

the AutoPaint buffer along the seagull’s tracked motion path.
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Figure 4:83  AutoPaint with Tracker Data

6. Play back the clip to evaluate your work. The seagull should now be

removed from the shot!

REINTRODUCING THE CAMERA MOTION

The final step in this lesson is to reintroduce the original camera motion

back into our clip. To do this we will be using the Stabilize filter from

under the Filters Menu.

1. Select Filters > Stabilize > Stabilize. The Stabilize window appears.

Figure 4:84  The Stabilize window

2. Since we want to restabilize the data, make sure that Wrap Edges is

checked.
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3. Control-click on the Position value. This will bring up the Timeline

Contextual Menu. Select Apply Tracking Data. This will allow us to

apply tracking data to the position value.

Figure 4:85  Applying the Tracking Data

4. The Apply Tracker Data dialog appears. This is exactly the same

window we used earlier when stabilizing the shot. The only differ-

ence is that instead of accessing it from the Motion Tracker palette

we are accessing it here, through the popup menu in the Timeline.

Figure 4:86  Apply Tracker Data Dialog

Destabilizing the shot is the opposite of stabilizing it. As such, we now

want to apply the opposite (or inverse) of stabilization. Select your post

motion data, make sure X Position and Y Position are checked, then

check Inverse for both values.
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5. Click OK to apply the motion data.

Once applied, the new motion data shows up as keyframes in the

Timeline window.

Figure 4:87  Position Keyframes

6. From the Preview Window, press play to preview the effect.

Figure 4:88  Previewing the Effect

The boat clip plays back with its original motion.

7. Press OK to apply the filter to the clip.
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Lesson 9: Motion 
Tracking (2)

Commotion’s ability to attach motion tracked data to Rotosplines

allows artists to easily isolate elements as they move around the frame.

In this example, we will blur the license plate on the car so the numbers

can not be identified.

In this lesson you will learn how to use the following features:

• Tracking multiple points simultaneously

• Applying track data to a Rotospline

• Scaling a Rotospline with track data

• Creating a matte from A Rotospline

• Applying a Filter effect

TRACKING THE LICENSE PLATE

1. Open the file licenseblur.mov. Open the Motion Tracker and

Rotospline palette by either double clicking on their tool icons, or

by selecting their palettes in the Window menu. Playback the clip

and notice that the license plate is moving in position and scale as

it gets closer to the camera. 

2. On the last frame, set up two motion trackers on either side of the

license plate. Shift click on both of the trackers and click on the

Track button. 
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Figure 4:89  Both Trackers Selected

3. The Motion Tracker dialog comes up. Use the default settings with

the exception of the Track in Reverse option, and choose a sub-

pixel accuracy of 1/32. Click OK to track.

Figure 4:90  The Motion Tracking Dialog

Once completed, the track should look like Figure 4:91.
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Figure 4:91  The Completed Track

CREATING AND SCALING THE SPLINE

4. Go back to the first frame and create a new Rotospline around the

license plate. Zooming in will help with the precision. Alternately

you can load in the license plate.path file in the tutorial folder.

Figure 4:92  The License Plate Path

5. Assigning the tracked data to the Rotospline will cause the

rotospline to follow the motion path, as well as scale appropriately.

Click on the Apply Tracker button in the Rotospline palette to attach

the tracked data.

6. Select Entire Spline and click OK
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Figure 4:93  The Motion Tracker Data Dialog

7. Choose Track-0 for X and Y Position, and Track-1 for Scale.

Figure 4:94  Apply Data to Curves

This will cause the spline to scale based on how far Track-1 moves

away from Track-2.

8. Now play back the clip, and you’ll see that the rotospline is moving

an scaling correctly with the license plate.

CREATING THE MATTE

9. Give the spline a nice soft edge by entering a Feather Setting of 5.
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Figure 4:95  The Rotospline Palette

10. Click on the Render button to render the spline into the Alpha

Channel of the current clip.

Figure 4:96  Render Options for Splines

APPLYING THE FILTER

11. From under the Filter menu, select ICE Blur from the Blur & Sharpen

submenu.
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Figure 4:97  The ICE Blur Window

12. Depress the Alpha On button to enable the alpha channel, so that

the effect is applied only to the unmasked area.

13. From the Comp Against menu, select licenseblur.mov. When the

blur effect is applied, the blurred license plate will be composited

against the non-blurred clip.

(For more information see Compositing and Alpha Controls on page
132.)

14. Make sure Link Vertical is checked, and set a Horizontal value of

around 5 pixels.

15. Click OK to render the effect.

Figure 4:98  The Completed Shot

The license plate will be blurred over the full range of frames, changing

position and scale as the car comes closer to the camera.
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Lesson 10: Motion 
Tracking (3)

For this tutorial we will track several objects on a ferry boat. This foot-

age was provided to us by Adventure Pictures.

In this lesson you will learn and/or use the following features:

• Tracking multiple points simultaneously

• Applying track data to a Rotospline

• Using Clone Source Overlay

• Applying Track Data to a SuperClone

TRACKING OBJECTS

1. Open the file ferry.mov.

It is not necessary to load the entire frame range of the clip, but if you

have enough RAM, load all 50 frames. For the tutorial we will assume

you have all frames loaded.

2. Open the Motion Tracker palette and create two new motion track-

ers.

3. Move the Track Target and Track Region markers to select the area

to track. Position one tracker over the smoke stack and place the

other over the lifesaver on the right.

Figure 4:99  Positioning the Trackers
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Remember, you can magnify a tracker and move it around to precisely

position your trackers by pressing 1-5 on the keyboard.

4. Once you are satisfied with the Track Target, shift-select both track-

ers in the Motion Trackers palette and then click on the Track But-

ton. For this track, choose Luminance and make sure SubPixel

Accuracy is set to 1/16th. Click OK to begin tracking.

APPLYING TRACKING DATA TO ROTOSPLINES

1. If it is not already open, press F7 to open the Rotospline palette.

Select Load All Paths.

2. Load the file lifesaver.path. This file contains a Rotospline for the

lifesaver on the side of the boat.

3. Go to frame 1 and select the lifesaver spline in the Rotospline pal-

ette. Click on the Apply Tracker button in the rotospline palette. In

the Apply Tracker Data dialog, choose Entire Spline and hit OK.

4. When the Apply Tracker to Curves dialog appears, select the

tracker that you used to track the lifesaver and click OK.

5. Play the clip. Notice that the lifesaver Rotospline is now correct

throughout the shot. 

Before proceeding, hide the lifesaver spline by clicking the eyeball next

to it in the Rotospline palette.

APPLYING TRACK DATA TO CLONE SOURCES

1. Open explosion.mov. In the Load Frames dialog, select frame 1 by

entering 1 in both the In and Out fields. You only need to load the

first frame because the SuperClone tool can pull frames from disk

as well as from RAM.

2. Once explosion.mov has loaded, collapse its window by clicking

the collapse button
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Figure 4:100  The Collapsed Movie

3. Next you will need to set up the SuperClone tool. Bring the boat

clip to the front and open the Clone Sources palette by pressing F8.

4. Select explosion.mov as the first Clone Source.

5. Hold down the Shift key while clicking and dragging in the clip win-

dow to position the explosion so that it appears to be coming from

the smoke stack.

Figure 4:101  Positioning the Flame Clip

6. Once you have done this, use the Current Frame Slider in the Player

palette to advance to frame 20. Notice that the explosion no longer

lines up with smoke stack due to the motion of the boat. You will

now compensate for this by applying the tracker data you previ-

ously created to the Clone Source.

7. Go back to frame 1. Click on the Apply Tracker Data button to the

right of the first Clone Source. 
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Figure 4:102  Applying the Track Data

8. When the Apply Tracker to Clone Source dialog appears, use the

upper popup menu to select the tracker that you tracked the smoke

stack with. Make sure that the lower popup menu is set to none and

click OK.

9. Return to frame 20. Notice how the Clone Source is now correctly

aligned with the smoke stack. Return to frame 1.

Figure 4:103  The Clone Source at Frame 20

10. Create a brush approximately 140 pixels in size, with a feather value

of 80%. Select Screen from the Transfer Mode popup at the top of

the Tool Options palette and turn on AutoPaint recording.

11. Paint in the explosion around the smoke stack. Remember, this

stroke will need to be large enough to paint in all of the explosion as

it grows larger, so make it big.
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12. Click the Apply Tracker Data button in the AutoPaint panel. Com-

motion automatically applies the recorded stroke on each frame of

the clip, following the tracker data as it goes. 

13. Now play the clip back and view your results!

Figure 4:104  The Finished Shot
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Lesson 11: Using 
Rotosplines

In this tutorial you will use several techniques to generate mattes and

touch up a plate.

• Rotosplines, creating multiple splines for different purposes.

• Painting to the alpha channel directly to create an articulate matte.

• Using the Composite command to preview a composite while

painting in an alpha channel.

• Using the Super Clone brush to tweak the final composite to make

the shot perfect.

INTRODUCTION

This tutorial will show you how to use one of Commotion’s most power-

ful features, Rotosplines. We’ll be using Commotion’s painting and

compositing tools to create a fast action stunt effect shot., which called

for the actor to appear dangerously close to a speeding car. To keep

the actor’s risk of injury at a minimum, two separate shots were taken:

one of the car and one of the actor running. Both shots were taken with

a locked off camera on a tripod to ensure that the backgrounds would

match perfectly.

Figure 4:105  The Rotosplining Shot
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PREVIEWING THE SHOT

Before beginning the project let’s take a look at the completed shot.

This will give you a better idea of what we are trying to accomplish with

this tutorial, and allow you to better understand why we’ll take the

steps we take to achieve the desired effect. 

Open the file named Stunt Chase (final).mov in Commotion and play it a

few times. Notice that there are two separate movements where the

stunt actor passes in front of the car: in the first 50 frames of the shot

he runs in front of the car from right to left, and then in frames 50-90 he

runs back across from left to right.

In the first instance the actual area of overlap between the car and the

actor is very small. Go to frame 9, the first frame of contact between

the two. Now move forward to frame 27, the last frame of contact.

Slowly scrub back and forth between these two frames and notice how

much of the runner actually obscures the car. It’s not much, really; basi-

cally his waist to his ankles. The amount of screen space taken up by

this action is relatively small, too, probably around 150x150 pixels.

Because of these factors we don’t have to be as precise as we will

when the actor is in the foreground, so we’ll create an articulate (hand-

painted) matte for his right-to-left movement by painting directly into

the alpha channel. Then, in the second part of the shot, when the

actor’s legs and torso are full-frame, we will use Rotosplines to extract

a much more precise matte, thus ensuring a better, more believable

composite.

MAKING A SPLINE FOR THE CAR

We’ve decided to create an articulate matte for the right to left move-

ment of the runner. First we’ll create an animated spline to outline the

car. Then we’ll import that spline into our clip of the actor to use as a

placeholder for the car while we paint our articulate matte. 
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Don’t worry if this sounds a little confusing. As we go along you’ll

quickly see how it all fits together.

ROTOSPLINES

Commotion has two different types of splines: Bezier and Natural.

Figure 4:106  Bezier Splines

Bezier splines function identically to their counterparts in such pro-

grams as Adobe Photoshop and Adobe Illustrator. Bezier splines are

controlled by keypoints and tangent handles. Adjusting these handles

controls the intensity of the curvature of an individual point.

Figure 4:107  Natural B-Splines

Natural splines, otherwise known as B-splines, are defined only by key-

points. The curvature of the spline is determined by how close the key-

points are to one another. While you may not be familiar with Natural

splines, they can be significantly easier to manipulate, especially in a
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situation where you have a great many points (which can happen a lot

in rotoscoping!)

USING NATURAL SPLINES

1. If you haven’t done so already, close the open clip. Open Stunt

Chase (BG).mov and load in at least 15 frames beginning at frame

1. (You’re going to be loading in more frames later, so don’t max

out!)

2. Double-click on the Pen tool to bring up the Rotospline palette.

Figure 4:108  The Rotosplines Palette

Look down in the bottom right corner of the window and you will see a

small button with a blank page icon in either blue or orange. This is the

New Spline button. The color of the New Spline button indicates the

type of spline it will create: blue for a Bezier spline, or orange for a Nat-

ural spline. There are two ways you can change the type of splines you

work with. The first is to select Curve Options from the popup menu

located in the top right corner of the window, which brings up the Curve

Options window.
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Figure 4:109  The Curve Options Dialog

Here you can select either Bezier or Natural Splines. Alternately you

can Option-click on the New Splines button, which will cause it to alter-

nate between being blue or orange in color.

3. Set the spline type to Natural (orange), and click the New Spline

button to create an untitled spline.

Figure 4:110  A New Spline is Created

The orange border next to the eye icon, on the far left of the spline

name, indicates that this spline is a Natural spline. If it were a Bezier

spline this border would be blue in color. This feature really comes in

handy when working with multiple splines of both types.
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You may be wondering about the color box to the right of the eye icon.

This is the Spline Color box and, as its name suggests, it determines

the color of the spline.

Figure 4:111  Spline Color

Since we haven’t created our spline yet let’s leave it set to its default

color. Once we have created a spline you can change it to another color

if you wish.

4. Okay, now we’re ready to actually create a spline. Don’t worry

about being super accurate here, this is just a test, so you can get

the hang of working with Natural splines. First make sure that the

Pen tool is highlighted in the Rotospline palette.

Set your clip to any frame you wish. Then, using a series of clicks, draw

a spline around the edge of the car. You’ll find that you’ll generally plot

more points with a Natural spline than you would with a Bezier spline,

but you will quickly learn to appreciate the greater degree of control.

Figure 4:112  The Outlined Car

To close the shape, click on the first point you created. If you wish to

make an unclosed (open) path, hit the Escape (ESC) key.

5. Select the Pointer tool and manipulate the points on the Natural

spline path.
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Pick a control point and push or stretch the path in any direction to fit

the shape of the car. Get a feel for how the points interact. Marquee-

select multiple points and move them all at once. Take a moment or

two and play around with the spline to get the hang of it.

THE SPLITTER TOOL

For the most part the tools function identically between Bezier and Nat-

ural splines. The only exception is the Splitter tool, which functions a lit-

tle differently.

Figure 4:113  Splitter Tool on Bezier Splines

On a Bezier spline, click once on a point with the Splitter tool to acti-

vate it, then click and drag to reveal the tangent handles. To remove the

handles click once on the point again to return it to its original state.
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Figure 4:114  Normal, Loose, and Tight

Natural splines, on the other hand, don’t require any dragging. Just

click to toggle between the three point tension settings: Normal, Loose,

and Tight. As you can see, these settings have a great deal of impact

on the curvature of the spline. As with Bezier splines you can add and

subtract points to Natural splines, keyframe the position of the points

to animate the spline over time, and instantly play them back over mov-

ing footage to evaluate your work in progress.

CREATING THE CAR SPLINE

Now let’s do some real roto work. First we’re going to accurately outline

the motion of the car. But first let’s delete the practice spline you have

been messing with. Make sure that Path-1 is highlighted in the

Rotospline palette, then click the little trash can icon in the bottom right

corner of the window. This is the Delete Path icon and it will, you

guessed it, delete any selected paths.

1. Set your clip to frame 1. Create a new Natural spline, and using the
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spline tools outline the car.

Figure 4:115  Outlining the Car

2. Go to frame 50. If frame 50 isn’t live, take the Live Frame selection

slider in the Player palette and move the range forward so frame 50

is the last live frame.

A progress bar will appear and the new frames will load in.

3. Now we want to select all the points on the spline to animate them

to the position of the car on frame 50.

There are three ways to select all points:

• Marquee-drag over the whole spline

• Option-click any point on the spline

• Type Command-A. 

Figure 4:116  The Clip at Frame 50

Once all the points are selected, drag the spline over to where the car is

now located by dragging any of the selected points.

Command-A
Select All

KEYBOARD SHORTCUT
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Figure 4:117  Moving the Spline

4. As you can see in Figure 4:117, the car is now larger than the area

of the spline. To fix this we’re going to scale up the spline to more

closely match the outline of the car.

Select the Scale tool from the Rotospline palette. The first thing you

need to do is determine the point around which the spline will scale.

Click somewhere in the center of the spline to make the selection.

Notice that the cursor changes once you have done so. Then drag any

of the points to scale the spline. You’ll notice it doesn’t fit exactly - just

make it reasonably close. (If you like you can use the keyboard arrow-

left and arrow-right keys to nudge the scale.)

Figure 4:118  The Scaled Splines

5. Then, using the Pointer tool, make fine adjustments to the spline to

make it fit around the car.

[
Figure 4:119  The Adjusted Spline
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THE KEYFRAME EDITOR

1. Play the frames you have worked on to review the spline move-

ment. You may notice on frames 20-49 that the spline gets too big

too quickly before the car moves into place. You can adjust this by

going into the Rotosplines Keyframe Editor which you access by

clicking the arrow tab in the upper right corner of the Rotospline

palette. 

Figure 4:120  The Rotospline Keyframe Editor

2. In the Keyframe Editor you can change the rate of interpolation for

the splines. Select the first keyframe by clicking the selection box

directly below Keyframe 1.

3. To change the keyframe interpolation type, choose the Easy Curve

type from the Keyframe Type Buttons on the right.

4. While the clip is playing, adjust the spline interpolation and get

immediate feedback to how that will effect the spline tracking.

Adjust the tracking until you get the spline to roughly follow the out-

line of the car through frames 20-50, but don’t worry if it is not per-

fect. 

5. Adjust the matte by adding new keyframes anywhere along the clip;

modify a shape and a keyframe will automatically be added.

You should definitely practice using the keyframe editor and setting

keyframes until you are comfortable with doing so, as these two tasks

are at the heard of getting successful results using rotosplines. Once

you have done so, and have a good animated Rotospline outlining the

car, you can save it out for use the second part of this tutorial. In the
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interest of time, however, we have provided a completed spline for you

to use instead.

PAINTING A MATTE

Before we begin this section, go ahead and close the car clip you have

been working in. Then go to the Rotospline palette, and with Path-1

highlighted, click the trash can icon in the bottom right corner of the

palette to delete it.

1. Open the file Stunt Chase (FG).mov and load in as many frames as

possible.

2. From the pulldown menu in the Rotospline palette, pick Load Single

Path and choose the file Car Path.spline.

3. Play the clip. The spline you created in the car clip is now being

used as a placeholder in the actor clip. If you like, press F1 to tog-

gle the visibility of the keypoints to Off. Notice where the actor and

the car spline paths cross between frames 9 and 27. Using the car

path as a guide you’ll create a matte of the actor in this clip’s Alpha

channel.

The next step is to paint into the Alpha channel while viewing that Alpha

channel overlaid with the RGB channel. There are three ways to set

these modes:

• Click the mode buttons at the bottom of the Clip window

• Type Option-O to overlay the matte

• Type Option-3 to paint on the Alpha channel

4. Select the brush tool and black as your foreground color. Since the

background is the same in both shots, rough strokes can be used

to paint the actor’s matte.

The car spline will serve as a guide to where you need to be precise

along the edges of the matte you are painting. (The overlaid alpha is

shown here as red.) 

Option-O
Toggles Overlay On and Off

Option-3
Paint Alpha

KEYBOARD SHORTCUT
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Figure 4:121  Painting the Matte

5. You can also look at your matte while you paint it by hitting com-

mand-4.

Figure 4:122  Viewing the Matte

Notice in Figure 4:122 how the matte areas inside the car spline are

very precise, while the areas outside the spline are more sloppy and

quickly-drawn.

6. You will only need to paint accurate edges from frames 9-27; from

frames 1-8 and 28-50, paint a sloppy quick matte. Remember to

paint the actor’s shadow as well, since you will want to composite it

into the final shot.
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Figure 4:123  The Sloppy Matte

PERFECTING THE MATTE EDGE

The alpha that you just painted should be checked. We’ll use Commo-

tion’s composite command to do a preview of the composite, and we’ll

tweak the matte edges and see how they affect the composite.

1. Set your View Mode so that you are viewing only the RGB channels.

2. Load frames 15-25 of the Stunt Chase (BG).mov file.

3. With the Stunt Chase (FG).mov clip active, option-click on the Com-

posite Button in the clip window, or select Composite from the Cal-

culate window.
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Figure 4:124  The Composite Dialog

In the Composite Window, assign the following settings:

• Leave the Transfer Mode set to Normal.

• Click the checkbox next to Matte, and select Source Image from

the popup menu.

• Set Comp Against to Clip and choose Stunt Chase (BG).mov from

the popup menu.

• Set your Destination to Preview.

• If you like, click the Preview checkbox in the lower left corner of the

window to see a preview of your composite.

You will now see your foreground clip composited against the back-

ground clip using the alpha you have painted. With your paint mode set

to Alpha (Option-3) you can continue painting with black or white ink

into the alpha, and get immediate feedback on how the composite will

look.
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ROTOSCOPE USING MULTIPLE SPLINES

Commotion has the ability to create multiple splines, and for the next

section this is exactly what we’re going to do. For complex, moving

shapes (such as our runner) using more than one spline offers a much

more flexible solution than trying to create a single master shape with

one spline only. When you have multiple splines, (think of them as a

stack of layers, with one spline on each layer, with the first spline being

on the top layer,) you can adjust the stack order of the splines in the

Rotospline palette.

1. With the Stunt Chase (FG).mov clip, move your Live Frame range to

include frames 50-90 (or as many of these frames as possible).

2. To continue the matte you painted by hand up to frame 50, make a

garbage matte of the actor using a Natural spline. Create a rough

outline of his entire body on frame 50, then move to frame 60 and

make another shape. Check the interpolation from 50-60 to make

sure the shape never touches the actor’s body.

Figure 4:125  Frames 50-60

Once the actor intersects the car mask for the second time (frame 60)

you will want to make precision mattes for every part of the actor's

body that come in contact with the car matte. For this exercise we will

use multiple splines to achieve the tightest mattes. 



TUTORIAL

com
m

otion
using

 ro
to

sp
lines

419
3. Start off by making a rotospline for the actor's left thigh using a

Natural spline.

Figure 4:126  The Leg Spline

You can use a combination of Natural and Bezier splines if you like.

You’ll want to maintain as much precision as possible when the actor’s

legs are overlapping the car. 

Using the Keyframe Editor you can turn mattes on and off at specific

frames, so that you can transition mattes in/out as needed. For exam-

ple, you can use a garbage matte for 10 frames, then have it disappear.

4. To complete the rotospline work we have included the rest of the

splines you would make for the actor's movements. Load the

splines called actor.splines into the clip from the Rotospline option

pulldown menu. Notice that several splines were used for the

actor’s right leg. but only one spline was used for the left leg. The

splines below the torso are very precise, while the upper body and

head are less accurate (since the sky edge is the same in both

clips).



TUTORIAL

com
m

otion
using

 ro
to

sp
lines

420
Figure 4:127  The Actor’s Splines

To view or hide all of your splines Option-click on one of the Hide/Show

spline icons

5. Pressing F15 or hitting the Preview button lets you see a preview of

the mattes. 

If you wish, experiment with using edge feathering and/or motion blur

with the splines. 

(For more information see The Rotospline Palette on page 289.)

6. Click the Render button and select To Alpha of Current Clip. This

renders the grayscale matte to the alpha channel of the current clip.

Figure 4:128  Spline Render Options
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COMPOSITING THE CLIPS 

1. If it is not already open, open Stunt Chase (BG).mov.

2. To composite the clips together for the final effect, once again bring

up the composite dialog from under the Calculate menu.

Commotion’s Composite command is capable of this type of direct

foreground/background composite. Puffin Designs, however, recom-

mends Adobe After Effects, an excellent compositing software pack-

age.

3. In the Composite window set Stunt Chase (FG).mov as your fore-

ground and Stunt Chase (BG).mov as the background. Use the

same settings as you did before. When you are ready to render the

composite, choose Flatten as your destination.

FIXING PROBLEMS WITH SUPER CLONE

For this last portion of the lesson you can either use the clip you have

composited or you can use the clip called Stunt Chase (near final).mov

that we have provided for you. (If you use your own clip be sure to

change the file name to something other than Stunt Chase (FG).mov)

1. Now that you have one complete clip to work with you can look for

imperfections that may have occurred. Go to frame 63 and notice

that the actor's shadow cuts into the car's shadow due to an over-

sight on the rotoscoping. 

Figure 4:129  The Shadow Error
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2. Go to frame 73 and you will notice the actor's leg blocks out the

image of the car incorrectly.

Figure 4:130  The Leg Error

3. Choose the Super Clone tool from the tool palette. In the Super

Clone window make Stunt Chase (BG) be your clone source. You

only need 1 frame loaded from the Stunt Chase (BG) plate (load

frame 1); as additional frames are needed they will be loaded auto-

matically by the Super Clone Brush.

4. Now you can paint in the shadow for the car. You will want to do

touch ups for frame 73 so change your absolute frame to 73 and

paint the car back into the shot.
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Lesson 12: The FX 
Brush

This tutorial will take you through the steps necessary to create and use

the FX Brush.

BEFORE WE BEGIN

It is important to note that as soon as you make any changes to an

existing brush, a new brush is created. You must save this brush in

order to keep it; otherwise those settings will only be saved until you

select a new brush. If the brush is not saved at this point, you will lose

it.

To save an FX brush:

1. Shift-click on a blank brush space in the bottom of the Tool Options

palette.

Figure 4:131  Shift-Click to Add a Brush

The cursor becomes a paint bucket. When you click the blank space

the Save FX Brush dialog comes up.

2. Create a name for your brush.
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Figure 4:132  The Save FX Brush Dialog

3. The new FX Brush is added to the Brushes palette.

CREATING AN FX BRUSH

1. With black as the background color in the Tool Options palette, cre-

ate a new clip:

• 640 x 480

• 30 frames.

• Save it as a Quicktime movie: Animation compressor, Best quality. 

Figure 4:133  QuickTime Settings

2. Choose the FX Brush in the Tool Palette. It does not matter which

brush is selected. 

3. In the Brush Controls, choose Settings. This brings up the FX Brush

Settings window, which is where you will build your FX Brush.
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Figure 4:134  FX Brush Settings Window

4. Click on the tile to the right of the word Pattern. This brings up a

load dialogue.

5. Go to the Lesson 12 folder on the Commotion 2.0 CD and load the

file tube.pict. This texture is what we will base the brush on.

Figure 4:135  Load tube.pict

6. Make sure the popup menu next to the second pattern reads Con-

stant. 

Constant means the brush will only use the first pattern. This is an

important concept for FX Brushes, as it is true for all the parameters.

With any setting other than Constant, the parameter will ramp between

the two settings. This ramp effect can be based on four parameters:

• Speed

• Pressure
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• Direction

• Tilt

If you have an Wacom Intuos or Art Pad tablet, you’re able to use all

four parameters, including Pressure and Tilt. If you only have a mouse,

don’t worry; you can still use Direction and Speed to ramp between

parameters.

7. Check the Tint checkbox and click on the color box below it and

select a deep blue color.

8. Next move down to the Brush section. Next to Opacity, lets set it to

100% and Constant.

9. Now set the Size to 20 in the first box, 30 in the second. Set the

pop up to Direction for a mouse; if you have a tablet, feel free to

experiment with Pressure or Tilt.

The pop up must be on something other than Constant to choose a

second parameter.

10. Now move the cursor over the scratch pad and paint a little. Exper-

iment with your stroke, based on what parameter you chose, to see

the Size ramping from your first setting to your next. Clear the

scratch pad.

Figure 4:136  Testing the Brush

11. Make sure the Spacing is set to 100/Constant.
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12. Lets ramp the Feather from about 50 to 100, and have it also base

itself on Direction. If you set up a different parameter earlier you

may want to set this to the same one, essentially locking the effects

together as you paint. Go to the scratch pad and paint. If its not

feathered enough for you, then set the first Feather number up.

Now paint again to see the change. Set to the Edge type of Feather.

If you want to see what the other types of Feathering do, simply

select each of them and paint on the scratch pad, clearing it each

time.

13. Now to the Effects section. This is where we can have some fun.

Set the first parameter to about 25 and leave on Constant for now.

Scroll through each of the effect popups, painting each time. Get a

feel for what each of these do. Diffuse, Bleed, Spin, and Shake.

They are each their own animal, so take some time and get a feel

for each one. Once done, lets leave this brush on Shake. Set the

first value to 10, and the second to 35. Have it ramp based on

Speed. Lets leave the second Effect option off for now, but we

encourage you to experiment with two effects on a brush.

Figure 4:137  Brush Settings

14. To see what Track does, check and uncheck Track and paint in the

scratch pad. When done, lets leave it off to get more of a writing

look, as we want our brush to look like it being written.

15. Lets also set a Border. Making sure it is checked, leave the default

value to 10, click on the color box and select a bright red. 
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16. Now take a last pass at the scratch pad to make sure your brush is

painting the way you desire. Once it is, click OK to go back to the

Clip.

Figure 4:138  Final Brush Test

17. Immediately Save your brush by Shift-clicking on an open space in

the Brushes section of the Tool Options palette

18. Now its time to use the FX Brush, choosing from one of several

ways to paint inside Commotion. Paint frame to frame for the most

precise effects. Stroke splines to create some different looks with

the FX Brushes, and to automate the process. Or, use AutoPaint!

AUTOPAINT

1. Turn on Record in the AutoPaint section.

2. Paint a write-on effect—a word or name—on the first frame. Turn

off Record and Revert the current frame. 

3. Select the Animate Playback button in the AutoPaint section, mak-

ing sure the selection range in the Player palette is from frames 1 to

30.

4. Hit Play after the stroke is animated and watch it play back!
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Figure 4:139  The Completed Write-On

5. We could stop here, but to really give it some life, lets build this up

with a few more brushes. Go to the Lighting FX Brush set and

choose the strangely-named Blue Flare brush.

Figure 4:140  Choosing Blue Flare

6. Turn on wiggle and open the Wiggle Settings under the pulldown

menu. Set both vertical and horizontal to 1. Set the Brush Size to

110 and the Spacing to 92. Now click Animate again. This will add a

sparkly glow in front of our write on. 
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Figure 4:141  Sparkly Glow

7. Select an FX Brush of your choosing and write it over the top of the

clip.

8. Congratulations!
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Lesson 13: Electric 
Image 3D Pan and Tilt

This Lesson details exporting 3D Pan and Tilt motion data from Com-

motion into Electric Image Animation System in order to create a classi-

cally fake UFO shot. This tutorial is only of benefit to users of both

Commotion and ElectricImage. You can find information on the Electric

Image Animation System at http://www.electricimage.com.

Figure 4:142  The Project

ENCOUNTER AT FRONT ROYAL 

By John Sledd

Compositing 3D artwork with preshot film or video footage is among

the most valuable postproduction tricks in the book. While wonderful

examples of this technique are plentiful, there is one problem that still

plagues artists who work on such projects—camera motion matching,

commonly referred to as matchmoving.

If you really take a look at many of these composites, there is often very

little, if any, camera movement in the preshot footage. The reason for

this is that it’s just damn difficult to match the motion of your 3D appli-

cation’s virtual camera to the motion of the real-world camera. I’ve read

http://www.electricimage.com
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a bit about rigs that will record and store their motion for import into

your 3D application, but these are not exactly mainstream solutions yet.

Thankfully, much of the work involved in this motion matching doesn’t

have to be quite so difficult anymore thanks to Commotion’s 3D Pan

and Tilt data export feature. As a matter of fact, it’s almost too easy.

I designed the following project to illustrate the power of this feature.

Sure, I could have used a better-quality, more professional-looking

project, but what better way to test a tracking feature than by trying

track the jerky haphazard flailings of the average weekend crappy-

camcorder warrior, caught up in the excitement of filming his first UFO?

OK, so maybe I didn’t have a choice about the jerky haphazard part…

or the crappy camcorder part either, but you get the idea.

THE LESSON

Basically what we’re going to do here is open some source footage in

Commotion, track an area within this footage, and then export the

tracking information. We will then use this information to stabilize our

3D elements in ElectricImage, so they appear to be part of the video

footage instead of dancing around on top of it. You will need either

ElectricImage 2.9 or an earlier version with Biovision Import enabled.

This tutorial was created with 2.9 so if you want to use the project files,

you will need EI 2.9. Besides, it’s just a great version so you should

have it anyway.

With that said, let’s move on.

SETTING UP THE PROJECT

1. Give Commotion as much RAM as you can spare.

For this tutorial, it doesn’t really matter if you can view the entire clip at

once. It’ll help you preview the effects of the tracking at the end but

that’s about it. The tracking function will go through all of the frames

whether they are live or virtual. I gave Commotion 175 megs which was
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slightly more than I needed to keep all of the frames live. If you don’t

have 175 megs to spare, don’t worry about it. Just give it what you can.

2. Launch Commotion, and open the clip called Saucer Source.mov

from the Source Files folder. The Load Frames dialog appears.

Figure 4:143  The Load Frames Dialog

Take a moment and inspect the clip information at the top right of the

dialogue box and note the frame rate of the clip (FPS.) Commotion

really doesn’t care about frame rates, only frame numbers, but you’ll

need this information in EI to keep things the proper speed when we do

our composite.

3. Make a note that this clip is 22.22 fps. (I know that’s a strange num-

ber but it’s what the Apple Video Player gave me when I captured

this footage on my 8500, so I just left it alone. This is supposed to

be a budget production anyway, right?)

4. So now let’s move down to the Load Frames section, located in the

middle of the screen in Figure 4:143. Right beside the note you took
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about the 22.22 FPS, (you did write that down didn’t you?), jot

down the total number of frames: 483.

5. Commotion will automatically offer to open as many frames as pos-

sible so just accept the defaults here and click OK. The rest of the

settings should be fine.

6. When the clip opens, click the Play Forward button as shown in

Figure 4:144, or simply hit the space bar. Check out the bouncy

motion of the clip.

Figure 4:144  The Player Palette

7. It’ll probably be playing a bit fast, which doesn’t really matter for

this tutorial, but if bothers you, click on the FPS pop-up menu in the

top left corner of the Player Palette (Figure 4:144) and select the

VAR option. This brings up the Speed dialogue (Figure 4:145.)

Figure 4:145  Variable Speed Dialog

8. Enter 22 and click OK. Why not 22.22 as we wrote down earlier?

Because Commotion does not support decimal places for frame

rates.
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This is not an issue, though, since you’ll probably never again be work-

ing on such a goofy frame rate; just let it ride and let’s move on.

TRACKING THE MOTION

Next we’re going to track this bouncy motion so we can eventually

apply it to our camera in EI. I chose the location of this particular shot

for the big smoke stack in the background. I thought it would be make

a good trackable object, which it did. Okay, let’s get tracking!

1. To track the stack, we first need to open the Motion Tracker palette.

There are three ways to do this:

• Select Motion Tracker from the Windows menu

• Press Shift-F8

• Double-click the Motion Tracker tool in the Tool palette.

Once you do this, the Motion Tracker palette appears.

Figure 4:146  The Motion Tracker Palette

2. To add a tracker, click on the New Motion Tracker Button at the bot-

tom of the Motion Tracker Palette. This will add an item to your

Motion Tracker palette called Track-0. If you’d like to rename this

tracker to something else, simply double-click on it and type a new

name in the dialog box.
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3. When you created the tracker it also added a couple of blue boxes

to your Clip Window, as seen in Figure 4:147.

Figure 4:147  The Default Motion Tracker Regions

About these two blue boxes:

• The inner box is the Track Target. It tells Commotion what to track.

• The outer box is the Track Region. It tells Commotion how far

around the tracked object to track it between frames.

This does not mean that the track region has to be as big as the total

area that the stack will travel; it simply means that it needs to encom-

pass the area that the stack will travel between any two given frames. If

the Track Region is small and the stack moves slowly, you should be

fine, but if the stack moves abruptly and travels outside of the Track

Region, you will lose the target. (I made this mistake the first time

around with this project, so let’s try not to do it this time.)

4. Our goal for this step is to set up the Track Target to tell us exactly

what to track, and set the Track Region to encompass the largest

range of motion between any two frames (but not too big, if you can

help it.) If you set your Target and Region up as shown in Figure

4:148, you should be fine.
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Figure 4:148  The Tracked Region

5. With that set up, simply click on the Track button at the top of the

Motion Tracker palette. The Track Options dialog appears.

Figure 4:149  Track Options Dialog

6. For this project we’re just going to use the default settings, so click

OK and watch the magic. At this point your two blue boxes should

be replaced by a crosshair, which should follow the smoke stack

throughout the animation.

While you are waiting for the object to be tracked, I should point out

that typically it’s a good idea to make sure that your tracked object
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doesn’t leave the frame, or be obscured by other objects in the scene.

For this tutorial, however, the tracked object does move off-screen at

the end, but since it’s at the end, it doesn’t really matter; the important

part is already taken care of. So, when your crosshair gets lost at the

end, don’t worry. 

If it gets lost anytime before the end, however, it’s probably an indica-

tion that you need to make your Track Region larger. There are a couple

of places where the stack moves a good distance between frames, and

if it moves outside of the Track Region the crosshair will just freak out

and start wandering around.

If you do lose your track, you have two options:

• Just enlarge your Track Region and track the stack again

• Load the file called stack.tracker from the Cheater Files folder. It

contains the exact tracker I used for the tutorial.

OK. We’ll assume you’ve either successfully tracked the stack or

wimped out and used mine. Either way, we can now move on.

Figure 4:150  The Completed Track
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Once you’re done tracking the stack, you should wind up with a nice

motion path as shown in Figure 4:150. This is the info we’re going to

export to Electric Image.

EXPORTING THE DATA

1. To export the tracking info as data that EI will understand, choose

Save All Trackers from the Motion Tracker palette’s pop-up menu.

Figure 4:151  Save All Trackers

2. Name the file something creative like My Stack Tracker and choose

3D Pan and Tilt from the pop-up menu.

Figure 4:152  Exporting the Data

Once you do that, the Export to 3D dialogue will appear.
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.
Figure 4:153  Export to 3D Dialog

3. All of your settings should be the same as in Figure 4:153, but if

they aren’t, change them to correspond and click OK.

Now you should get another 3D Tracker Export dialogue asking you for

your camera’s Horizontal Field of View (FOV). This should be the same

as both your EI Camera’s FOV and your original shooting camera’s

FOV.

4. Enter 36.8699 in this field. This is what I used for this particular

tutorial, and it also happens to be EI’s default FOV. If you’re doing

this for your own project, you should take notes on these settings

from your shooting camera.

Congratulations! We’re now done with our tracking and exporting. Quit

Commotion and open EI (or just open EI if you have the RAM,) and let’s

proceed to the next step.

SETTING UP THE EIAS FILE

I’ve already done most of the work on the ElectricImage project file for

you. (I’m already on page nine of this tutorial and I don’t want anyone
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falling asleep on me.) Besides, I figure you probably already know how

to set up an EI project, so there’s no sense in a rehash.

1. Open EI and open the project file called No Track.eias in the Project

Files folder. This may take a moment to open, so don’t freak out if it

looks like your computer locked up for 30 seconds or so.

This is our saucer project all set up with one main thing missing—our

motion data. The background is shaking around like crazy and our

camera is stationary. If you rendered this project right now, it would

look like a bad 60s sci fi f/x shot. To see what I mean, check out No

Track.mov in the Finished Movies folder.

The goal here is to use the motion data we just got out of Commotion

to control our camera which will, in turn, match our 3D motion to our

live-action footage. This is almost as easy as easy gets but there is one

huge thing you have to pay attention to first and that is the FPS setting

in EI.

2. Pull up the Render Info Window by typing Command-R, and click

on the Timing tab.

EI defaults to an FPS of 30, and since our footage was recorded at

22.22 fps, this will cause problems when importing the motion data.

Why? Because the motion data comes in as custom frames, and the

frame counts must match up for this to work.

A 21.7 second animation at 30 fps creates 652 frames, while the same

animation at 22.22 fps creates 483 frames. (483 just happens to be the

number of frames of our source footage I asked you to write down ear-

lier.) The frame count must always match with the motion data frame

count for custom frames to work properly.

3. So, without beating this into the ground anymore than we have to,

change the FPS to 22.22 and your number of frames should auto-

matically change to 483.

Now we’re ready to import our data.
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IMPORTING THE MOTION DATA

1. Let’s import our motion data by choosing File>Add>Motion Data.

Navigate to the 3D Pan and Tilt file we created earlier. (You were

supposed to call it something like My Stack Tracker.)

You can also use Sledd’s Stack Tracker in the Cheater Files folder, if

you’re feeling lazy and just skipped the first part of this tutorial.

2. Once you find your file, click Open and choose Yes for all four dia-

logue boxes you are presented with. What you’ll wind up with here

are two effectors in the center of your scene. The parent effector

controls the position of your motion data and the child effector con-

trols the actual pan and tilt data.

Now all you need to do is apply this data to your camera and you’re

done.

3. To apply this data to your camera, open up your Camera Info win-

dow (Figure 4:154), and the Effector Info window for the parent

effector (Figure 4:155).

I
Figure 4:154  The Camera Info Window
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Figure 4:155  The Effector Info Window

4. What you’ll want to do here is copy the Camera’s position info into

the Effector’s Info Window. Since I’ve kept this scene pretty simple,

the Camera is positioned at 0,0,-2000. All you really have to do is

enter a value of -2000 in the Effector’s Z position field. This will

position your effector in the same space as your camera.

5. With that done, simply link your camera to your newly imported

motion data’s child effector as shown in Figure 4:156.

Figure 4:156  Linking the Camera to the Motion Data

6. And that’s it!

If you’ve set everything up correctly, you should now be able to render

and get a movie very similar to Encounter.mov, which you can find in

the Finished Movies folder.

Now if you’re trying to get the Men In Black interested, I’d suggest add-

ing things like shadows, motion blur and sound, but at least you’ll have

a good start on getting the motion right.
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END NOTES

Since I really pretty much glazed over the setup of the EI file, I wanted

to point out a few things that might make your life easier when you go

to work on your own file.

Know your camera distance:

For starters, it’s a good idea to know how far away your camera was

from your target object so you can be more accurate with your sizes

and distances. If you can get that data directly from the source that is

certainly the best way, but this often won’t be the case. In this instance,

I had no idea how far away I was from the smoke stack. I guessed at

about 1/2 mile, but to test that theory, I took another approach.

• I decided to take a guess at the diameter of the stack. My guess

was about 20 feet, so I added a standard shape sphere to the

project with a radius of 10 units. This gave me a sphere that was,

supposedly, the same diameter as the smoke stack. From here,

guesstimating the distance of the camera to the stack was a

breeze.

• Since I hadn’t moved the camera, the sphere was directly in the

middle of the camera view window. I simply dollied out until my

sphere was about the same size as the smoke stack. That gave me

a good estimate of right around 2000 units (which I was using as

feet,) so I just evened it off at -2000 on the Z axis.

• Once I had the distance down, I changed the sphere to be 400 units

in diameter, did my actual data import and linking, and used a sta-

tionary sphere to test the motion of the camera and make sure

everything was synching up properly. You can see this test render

by checking out Still Sphere.mov in the Finished Movies folder.

• After that, I used the sphere to map out my animation path and fog

level for the saucer and did another test render. Only after I was

happy with the motion and the fog level did I import the saucer, line

it up with and link it to the sphere. I then turned the sphere off and

rendered the final animation.
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This project used a very simple scene layout with a completely straight

forward camera shot to keep the complexity down, but it doesn’t have

to be that way.

If you require a more complex angle for your camera position:

• Position the camera for your shot using the background image as

reference

• Once you are happy with the position of the camera, send the

effector to the camera’s position

• Link the camera to the effector. All motion from that point will be

based on the camera’s current position and rotation.

And that’s the end of our 3D Pan and Tilt data tutorial. Good luck!

John Sledd is the big cheese at Sledd Studios, an illustration and animation
studio in Front Royal, Virginia. He is also the author/editor of the ElectricIm-
age Handbook <http://www.charlesriver.com/titles/elecim.html> published
by Charles River Media. His personal website is http://www.sledd.com, and
he can be reached via email at john@sledd.com.

http://www.charlesriver.com/titles/elecim.html
http://www.sledd.com
mailto:john@sledd.com
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